Users Guide
Time4Pay o ers a simple yet powerful way to keep track of the time you
spend on projects. A timer keeps track of the amount of time you spend
during a work session. These recorded session times can then be used to
generate an invoice which can be emailed to your client.
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Other features such as the ability to include at rate items, project status
history, project notes, and exible project reporting make Time4Pay an
ideal solution for anyone who needs to easily track time spent working on
projects and to send invoices to their clients.
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Getting Started
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Upon launching Time4Pay the Registration window will come up. To use
Time4Pay in trial mode (for up to 20 days) click the Try It Out button. To
register the program click the blue “here” link. Upon completion of the
registration process you will receive a serial number to enter in the
Registration window’s Serial Number eld. Next enter your name and click
the Register button to permanently unlock Time4Pay.

Setup

Although the Preferences can be set or changed at any time it is a good
idea to do this right away. To do so choose “Preferences…” from the File
menu.

Invoice Folder: To choose a location for invoices to be saved to click the
Choose Folder button. The chosen location will be the default location
shown in Save dialogues for invoices and reports.
Data Folder: By default Time4Pay stores your data in your User/Library/
Application Support folder. However, if you use Dropbox you can choose

to have your data saved there. Doing so allows you to sync Time4Pay data
between all computers that share the same Dropbox account.
Sort Project List: Here you can choose which column project will be
sorted by when the Manager window opens.
Currency Symbol: Enter your local currency symbol here to have it used
in invoices and reports.
Default Rate: The amount entered here will be the default rate for new
projects. It can be modi ed in the project window for a particular project.
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Minimum Billing Time: If you enter a number of minutes here any
sessions that end with fewer minutes will be rounded up to this number of
minutes.

Invoice Tab:
The text elds can hold information that you want to appear at the top of
invoices.
NOTE: If a Company Name is entered it will be used for invoices and
reports, and on the Manager window.
Footer Text: Text entered here will appear at the bottom of invoices.
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Open invoices after creating them: If this box is checked Time4Pay will
automatically open invoices when they are saved making it easy to send
them via email to your clients (see the Invoices section)

Invoice Header Image: You can use a custom header image instead of
the default header. To do so you will need an image 1060 pixels wide and
270 pixels high with a resolution of 150 dpi. The image should be in JPEG
format.
To use your custom header image click the Select button under the image
area and choose your image. Be sure to click Save after selecting your
image.
If at some point you decide you would rather use the default header
instead of a selected custom image check the “Use default header”
checkbox.

Style Options Tab:
Invoice Highlight Colour: Click Select Colour to choose a highlight colour
for invoices.
Invoice Header Font and Size: To choose a font for your company name
in invoice headers click the Select Font button.
To make sure your company name ts properly on invoice headers, adjust
the size of the text so that it ts in the coloured rectangle using the Size
popup menu.
About Fonts: Depending on the fonts installed on your computer some
fonts may not display properly in invoice headers. If a font that should
have a distinctive face appears as a generic font in the Header Font list
this is probably the case for that font.
Project Window Header: Use the Select Color button to select a color for
the header region of project windows.

Adding Clients

The next thing that you will need to do is add at least one client in the
Client tab of the Manager window. This window opens when you start the
program. You can also open it from the Window menu. It has a Projects
tab and a Clients tab. To add clients go to the Clients tab.
Importing Clients
To import clients from a .csv le click the Import Clients button and follow
the onscreen prompts.
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To Add Clients Manually
Click the Add icon to add a row to the client list. Enter a company name.
(This column should not be left empty as it is used when a new project is
created. If the client is not a company enter the client’s full name.) Press
the tab key to move to the First Name column. Continue to tab through the
columns and enter the appropriate information. It is okay to leave column
cells empty (except the Company column) but it is recommended that you

Client information can be edited by clicking on the cell in the list that you
want to edit.

Add as many clients as you want. You can always add more at any time.
Once a client has been added to this list you can create a project for that
client.

Creating a Project

To create a project for a client that you have added in the Client tab go to
the Projects tab. Click the New icon.
In the New Project window select a client from the dropdown menu. Enter
a name for the project and click the Create button.
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ll in at least the rst three column cells (Company, First Name, and Last
Name).

The project’s window will come up. At the top left is information about the
project: the Project Number (invoice number), Start Date, Status of the
project, and the name of the Client. To the far right is the Session Timer.
There is also a button to create an invoice for the project.
Project Status:
Using the Status dropdown menu you can set
the status of the project to: In Progress, On
Hold, Invoice Sent, Overdue, or Paid.
Whenever the status of the project is changed
the date of the change and the selected status
are recorded in the Status History list. This list
can be handy for looking back over the
progress of the project over time.
A project’s status is also indicated on the
Project tab of the Manager window in the
Status column.

In progress
On hold
Invoice sent
Overdue
Paid

The status of a project is indicated in the Manager window using the icons
above.

There are ve tabs in the middle section of the project window: Sessions,
Flat Rate, Info, Resources, and Payments.

About Sessions
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A session is a block of time that you have put in on the project. To begin a
session enter a Rate in the eld in the upper portion of the window. Then
click the Start button in the Session Timer region. When you do this the
Start button’s label turns to Pause. You can pause and resume a session
using this button. To nish a session click the End button. When you click
the End button the Date, Time, and Rate for the session will be added to
the sessions list. You can then enter a description of the work that was
done during that session.

The Session Timer:
Sessions times are recorded using
the Session Timer on a project’s
window. Sometimes it may be
inconvenient to have the project
window taking up space while you
are working on the project in
another application. When this is
the case click the > < button to
collapse the window to just the timer area. To return to the full project
window click the < > button.

About Flat Rates
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Flat Rate items are items that you charge a at rate for such as website
hosting or creating a logo. Also any supplies you may have purchased for

the project can be charged to the client as a at rate item. Flat Rate items
can be add to a project in the Flat Rate tab. To do so click the Add button.
A row will be added to the Flat Rate items list. Enter the amount and the
description for the item. Flat Rate items can be edited by selecting them in
the list then clicking again in the Amount or Description cell.

About Payments
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If a client makes a payment toward the full cost of the project you can
enter it in the Payments tab. Payment amounts are subtracted from the
Grand Total.

About The Info Tab

Status History:
Whenever the status of the project is changed using the Status popup
menu a record of the change is added to the Status History list with the
date of the change of status. This provides a way to look back over the
development of a project as it progresses or at some point in the future.
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Project Notes:
The project notes eld is for keeping any project related notes.

About the Resources Tab
In the Resources tab you can drag and drop les or folders onto the list
area to create links to items related to the project.

Saving Projects
When a project window is closed it’s data is automatically saved and it is
added to or updated in the Projects list in the Manager window.

Opening Saved Projects
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To open an existing project from the Manager window double-click on the
project in the projects list. It is possible to open more than one project at a
time.

Invoices
To create an invoice for a project click the Create Invoice icon in the top
region of the project’s window. Time4Pay creates and saves invoices in
PDF format. There are a number of settings in the Preferences that can be
set to a ect the content of invoices. (See the Setup section at the
beginning of this guide.)
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Invoice with default header

Invoice with custom image header

Emailing Invoices: To easily attach an invoice (that is open in Preview) to
an email message go to the File menu in Preview and select Share. In the
submenu select Mail.
When the email comes up
you can copy the client’s
email address from the Client
tab of the Time4Pay
Manager window, enter a
subject and send the email.

Reports
Time4Pay can produce a variety of reports.

To create a project report click the Create Report button on the Projects
tab of the Manager window. Reports can be organized by client, date,
status, project name, invoice number, amount, or a combination of these
project list columns. Project reports can be con gured in two ways. You
can arrange the order of the projects in the project list by clicking on any
column heading. This will list the projects in ascending or descending
order according to the column heading clicked. Also you can select which
projects to include in the report by selecting them in the projects list.
Using these two methods you can, for example, create a report of the
projects that have a paid status and that have a date within the last month.
To do this you would rst click the heading for the Status column. This
would group the projects by status. Next you would select those projects
(within the grouped paid projects) having a date within the past month.
With this arrangement a report of the paid projects for the month selected
would be generated when the Create Report button is clicked.
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NOTE: If no projects are selected in the projects list the report will include
all of the projects in the list.

Client Lists
To create a list of your clients in PDF format click the Client List icon on
the Clients tab of the Manager window.

Archiving and Reinstalling
Projects
Projects can be removed from the Manager window’s Projects list by
achieving them. To archive one or more projects select the project(s) in the
list and then select “Archive selected projects…” under the File menu.
Select a folder to archive the projects in and click Select. The selected
projects will be moved from the Time4Pay data folder to the folder just
selected and removed from the Manager window’s Projects list.
Projects that have been archived can be reinstalled using the “Reinstall
archived project…” menu item under the File menu.

Contact ToThePoint Software
Website: ttpsoftware.com
Email: info@ttpsoftware.com

